Introduction to Pspice®

1. Objectives

The learning objectives for this laboratory are to give the students a brief introduction to using Pspice® as a tool to analyze circuits and also to demonstrate the use of a small signal model as an example of a dependent source. The latter is done by constructing a simple voltage follower circuit using a transistor to amplify an input current.

2. Background

The Simulation Program with Integrated Circuit Emphasis (SPICE) was developed in the Department of Electrical Engineering and Computer Science at the University of California at Berkeley. SPICE is capable of performing DC, AC, or transient analysis. It was originally designed to analyze a circuit that was solely defined by a series of statements that constituted a “Net list”. With the advent of personal computers, the graphical user interface of the program evolved into its current state (The ‘P’ in PSpice® comes from Personal Computer). In the current environment, users can also enter circuit diagrams in a schematic layout (once simulated a netlist is still generated). This latter technique will be utilized in this and subsequent labs for the purpose of simulating and analyzing circuits.

In addition to this lab, the student version of PSpice® is available on the computers in MWAH 102 and is also available to download on-line (see the course syllabus for directions). For the remainder of this lab “Pspice®” will refer to the student version of the program.

3. Prelab

Calculate $V_x$ and $I_x$ in Circuits 0 and 1 (Figures 1 & 4). Record the values in Table 1.

4. Procedure

4.1. Equipment

- PSpice® on Personal Computer
- Agilent E3631A DC Power Supply
- Fluke 8050A Digital MultiMeter (DMM)
- (2) 1 kΩ Resistors
- (1) 2N2222 Transistor

4.2. Pspice® Tutorial

PSpice® is a window-based program and can be accessed from the program menu under the grouping of “PSpice Student.” Since we will be using the schematic entry option, open this up first (called “Schematics” in the program grouping).
As an example, we will construct the circuit shown in Figure 1.

![Figure 1: Example (Circuit 0)](image)

To construct the circuit shown, you will need to:

1. Insert each part,
2. Assign the appropriate value, and
3. Connect the parts by drawing wires.

### 4.2.1. Inserting and Manipulating Parts

Parts can be inserted by clicking on the “Get New Part ...” option under the “Draw” menu (you can alternately use [Cntl + G] as a shortcut or click on the button with a gate and set of binoculars). For now, all parts that we will need should be listed in the “Part Browser Basic” window that subsequently pops up. For the parts in Figure 1, you will need to choose (by highlighting) the appropriate part and then clicking on the “Place & Close” button. A list of commonly used parts is listed in Figure 2.

- **GND_EARTH**  Ground
- **R**  Resistors
- **C**  Capacitors
- **L**  Inductors
- **VDC**  DC Power Source
- **VAC**  AC Power Source

![Figure 2: Commonly Used Parts and Their Library Abbreviations](image)

To place a part, simply drag the cursor to the desired area of the schematic and then left click. The program allows you to place multiple instances of the same part with subsequent left clicks. When you have finished placing all the desired instances of a particular part, clicking the right mouse button will allow you to return to the selection cursor (white arrow). Another command that will be useful when drawing schematics is the “Rotate” command which can be found in the “Edit” menu or by using the shortcut [Cntl + r]. First select the part (the program will highlight it in red), and then use the “Rotate” command.
Once you have entered the two voltage sources and 3 resistors into your schematic, you will need to modify the default values. This can be done directly by double-clicking on the value or by double-clicking on the part and then selecting the attribute from the subsequent list. When changing the value, you will need to use the appropriate suffix. The list of parameter suffixes that PSpice® recognizes is listed in Figure 3. It is important to note that PSpice® is not case sensitive. This means that ‘Meg’ = ‘MEG’ = ‘meg’.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Suffix (case sensitive)</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tera</td>
<td>‘T’</td>
<td>$10^{12}$</td>
</tr>
<tr>
<td>Giga</td>
<td>‘G’</td>
<td>$10^{9}$</td>
</tr>
<tr>
<td>Mega</td>
<td>‘Meg’</td>
<td>$10^{6}$</td>
</tr>
<tr>
<td>Kilo</td>
<td>‘K’</td>
<td>$10^{3}$</td>
</tr>
<tr>
<td>Milli</td>
<td>‘M’</td>
<td>$10^{-3}$</td>
</tr>
<tr>
<td>Micro</td>
<td>‘U’</td>
<td>$10^{-6}$</td>
</tr>
<tr>
<td>Nano</td>
<td>‘N’</td>
<td>$10^{-9}$</td>
</tr>
<tr>
<td>Pico</td>
<td>‘P’</td>
<td>$10^{-12}$</td>
</tr>
<tr>
<td>Femto</td>
<td>‘F’</td>
<td>10-15</td>
</tr>
</tbody>
</table>

Figure 3: Parameter Suffixes

In addition to the above steps, you will need to connect your components by drawing wires. This can be done by choosing “Wire” under the “Draw” menu or by using the shortcut [Cntl + w]. To connect two points, simply click on one point and then the other. If the wire needs to contain more than one 90 degree angle, you can click on a point in the grid and the program will bend the wire there and allow you to continue stretching it in a new direction. To exit the mode, again use the right-click of the mouse.

4.2.2. Simulating and Analyzing Voltages and Currents

Next you should save your schematic (*.sch). After saving, you can then simulate your circuit(s) by choosing “Simulate” under the “Analysis” menu or by pressing F11 (the program will prompt you to save the schematic if you have not already done so). At this point, the program should give you an error. This occurs because the circuit is not yet grounded (it is good to make note of the error for future reference as this is a common mistake). To fix the error, insert the part called GND_Earth.

The circuit should now successfully simulate (and will pop up the A/D window). Make sure you are in the schematic window and look in the upper right portion of the tool bar. There should be ‘V’ and an ‘I’ button that will display the voltage at all nodes (in green) and the currents through all elements (in blue). You should be able to now click on each green or blue marker individually and see a dashed line indicating what node/element the measurement is assigned to. It is important to note the direction of the current when selecting the blue measurements. You can also toggle currents and voltages on/off at individual points in your circuit by selecting them with your cursor and
then pressing the adjacent voltage (V, lines and a dot) and current (I and an arrow with a line) buttons.

The last step in the tutorial is to change the precision of the labels that have just been presented. To do this click on the “Display Results on Schematic” option in the “Analysis” menu. This should bring up a set of suboptions to the right, from which you will need to select “Display Options...”. For subsequent results, you will need to display four (4) significant digits.

One last helpful hint is to take note of the pull-down menu about 2/3 of the way to the right on the tool bar. This menu contains recently added parts and can speed up the process of entering them.

4.3. Additional Circuits in PSpice®

In order to practice the procedure in the tutorial section, construct and simulate Circuits 1, 2, and 3 shown in Figures 4, 5, and 6. In order to do so, you will also need to use a current source (IDC), a current-controlled voltage source (H), and a current-controlled current source (F). Make sure to adjust the gain of each dependent source to the appropriate value by double-clicking on the part and changing the attribute. Record the values of $V_x$ and $I_x$ for each of the circuits in Table 1 (did your prelab values match the simulated values for Circuit 1?). **Have your lab instructor sign** that you correctly measured the voltage and current in one of these circuits (it does not matter which one).

![Figure 4: Circuit 1](image-url)
4.4. Voltage Follower

For the last portion of this lab, you will construct a voltage follower circuit (so named because the output voltage is equal to—i.e. “follows” the input voltage) that uses a transistor to amplify the current and then model the circuit in PSpice® using the actual transistor part and also a small circuit model of it. The usefulness of such a circuit is that it allows a device with a lower current (and therefore less power) to drive a device that requires higher current (more power)—one example of this would be when using a microcontroller to power a motor.

4.4.1. Physical Circuit

The first step is to construct the voltage follower circuit shown in Figure 7. In this figure, C, B, and E, refer to the collector, base, and emitter of the transistor, respectively. The ordering of these pins can be found in Figure 8. For the source voltage, connect banana-plug-to-alligator-clip leads from the DC power supply to the other nodes of your circuit.

Important: **Have your lab instructor verify your connection before energizing your circuit.** For a voltage source of 2 V, 4 V, and 6V, measure the voltage (with respect to ground) and current at the base of the transistor. Also measure the voltage at the emitter (with respect to ground) and the current at the collector of the transistor. *Record these values in Table 2 and have your lab instructor sign that you measured them.*

4.4.2. Circuit with 2N2222 Part

Next, construct the same circuit (Figure 7) in PSpice®. In order to accomplish this, you will need to insert the transistor symbol, which is Q2N2222. Set the voltage source to 2V, simulate and record the values for voltage and current at the base, the voltage at the emitter, and the current at the collector in Table 2. Repeat the simulation for 4V and 6V. **Save this file or a screenshot of one of the instances to include in your report.**

4.4.3. Circuit with Small Signal Model

Bipolar Junction Transistors can also be modeled by an independent voltage source across the B-E terminal coupled with a current-controlled current source (CCCS) between the collector and emitter. This model is shown in the context of the original circuit in Figure 9 (note that this is a simplified model that only roughly approximates the behavior for small signals). Construct this circuit in PSpice®. Set the voltage of $V_{BE}$ to 0.7 V and the gain of the CCCS to 160. Simulate your circuit for a 2V, 4V, and 6V source and record the values for the voltage and current at the base, the voltage at the emitter, and the current at the collector in Table 2. **Save this file or a screenshot of one of the instances to include in your report.**
5. **Housekeeping**

- Erase your files from the hard disk of the computer (if applicable).
- Return all parts to their appropriate bins.

6. **Conclusions & Questions**

This concludes Lab 3. If time permits, you are encouraged to explore other functionalities of Pspice®.

In addition to attaching the last page of this lab (with your calculations, measurements, and signatures) and the PSpice® diagrams from subsections 4.4.2 and 4.4.3, please answer the following questions in your lab report. Make sure to **numerically justify your answers where possible**.

1. What is the percent difference between the measured values for the voltage follower circuit and the simulated values (with the Q2N2222 part).

2. Does the voltage follower “follow” exactly? What is the percent decrease?

3. Explain why the “equivalent” circuit for the transistor is not equivalent. Hint: Are the gain for the CCCS and voltage for the independent $V_{BE}$ source constant in our simulations? Are they constant in our measurements?

4. Comment on when it would and would not be appropriate to use PSpice® to simulate a circuit as well as any portions of the lab which you found difficult.

**References Cited**

Data Entry and Lab Instructor Signature Page

Attach this page to your report.

Table 1: \( V_x \) and \( I_x \) Calculations for Figures 1 Through 3

<table>
<thead>
<tr>
<th>Circuit</th>
<th>( V_x ) (Volts)</th>
<th>( I_x ) (Amps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (PRELAB)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 (PRELAB)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Signature for Prelab – Circuit 0 and 1 _________________________

Table 2: Calculations and Measurements for Voltage Follower Circuit

<table>
<thead>
<tr>
<th>Circuit</th>
<th>( V_B ) (Volts)</th>
<th>( I_B ) (Amps)</th>
<th>( V_E ) (Volts)</th>
<th>( I_C ) (Amps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Physical Voltage Follower</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2V</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4V</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6V</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSpice® with 2N2222</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2V</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4V</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6V</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PSpice® with Controlled Sources</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2V</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4V</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6V</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Signature for 4.3. – Circuit 1, 2, or 3 _________________________

Signature for 4.4.1. – Physical Voltage Follower _________________________